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01 INTRODUCTION 
 
 
 

Dear Client, 
 
Thank you for having chosen our autoclave, we know how to exchange your fidelity, with 
maximum attention and service definitely corresponding to your expectations. 
 
Before using this autoclave, we invite you to read with maximum attention the user’s 
manual and then keep it in a place accessible to all operators in charge of STERILIZATION. 
 
Sterilise means adopting a specific working methodology and adhering to precise 
operational protocols: 
 

DISINFECTION obligatory phase, to ensure operator safety, to be done with immersion in 
chemical liquids or thermo-disinfection; 

 

CLEANSING the most important phase that ensures the removal of all types chemical and 
organic residues. The most suitable instruments are ultrasound baths; 

 

DRYING essential phase, which prevents corrosion of the instruments and interference of 
the STERILIZATION cycle; 

 

ENVELOPING essential phase for sterility maintenance over time; 

 

STERILIZATION final step steam STERILIZATION. 

 
 
 

The autoclave is the key point of this methodology. 
 
 
 
 
We remind you that failure to carry out all the phases of the STERILIZATION process may 
invalidate the final result.  
 
For installation, maintenance and assistance ask exclusively for a technician authorized.  
We invite you to use and ask for exclusively original spare parts. 
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02 USE AND DESTINATION OF USE OF THE AUTOCLAVE 
 
The autoclave is able to sterilize the three types of load provided for by the standard 
EN13060, especially: 
 

 

 ONYX-B 5.0 ONYX-B 8.0 

METAL OR SOLID MATERIALS 
Instruments with no cavities and no obstacles to 
the penetration of steam 

max kg. 5 max kg. 8 

POROUS OBJECTS 
Simple or composite materials that can absorb 
fluids (fabrics, gowns, surgical gauzes, 
dressings, etc) 

max kg. 1,5 max kg. 2 

 
HOLLOW OBJECTS 
Materials or devices with cavities, obstructions, 
etc. These are subdivided into two types, 
classified according to the length and diameter 
of the cavity.  

 
Approximately: 

 
TYPE B: cannulas, tubes or devices with large 
passages. 
 
TYPE A: turbines, hand pieces and devices with 
blind or small holes 
 

max kg. 5 max kg. 8 

 

The charges (Kg) change depending to the type of cycle which is performed. Watch 
Fig.B. 

 

*Only for European Countries 

 

 

The autoclave shall only have to be used for the sterilization of tools and 
materials being compatible with the steam sterilization system.  
Always make sure that the loads that need to undergo sterilization can 
stand the temperatures scheduled for the selected cycle. 
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03 SAFETY 
 

3.1 Safety marking 
  

 

HAZARDOUS 
VOLTAGE 

 

HIGH 
TEMPERATURE 

 

DISCONNECT 
THE POWER 
BEFORE 
REMOVING 
THE LID 

 

EARTH 
CONNECTION 

 

3.2 Safety devices 
 
The following safety devices are installed: 
 

1. Safety valve set at 2.4 bar  0/+10% 

2. Electromagnetic lock to prevent the door from opening while the cycle is running 

3. Resistance over temperature thermostats  
 

3.3 Safety notes 
 
1. The manufacturer is liable for the marketed product in accordance with current 

regulations. The manufacturer's liability will expire when operations are carried out 
on the device, or a part of it, by unskilled personnel or using non-original spare parts. 

2. There should be no potential risk of explosion and/or fire in the room where the 
autoclave is installed. 

3. The autoclave should be installed in a special well-ventilated room. 
 
3.4 Disposal 
 

 

 

  Refer to annex 
Cod. 0Z00H0004 
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04 TECHNICAL DATA 
 

  ONYX 5.0 ONYX 8.0 

M
E

C
H

A
N

IC
A

L
 D

A
T

A
 

Working temperature +5°C  +40°C 

Maximum altitude 2.000 m 

Max relative humidity at 30°C 80% 

Max relative humidity at 40°C 50% 

Dimensions of space occupied 
(L x H x P) 

474 x 497 x 650 474 x 497 x 795 

Space occupied with open door 495 mm 

Weight (empty tanks) 60kg. 66kg. 

Weight (full tanks + room full) 70kg. 76kg. 

Weight of area of support 2058 N/m2 

Potential sound level < 70 db A 

E
L

E
C

T
R

IC
A

L
 

D
A

T
A

 

Power voltage 230 V a.c. +/-10 %  single phase 

MAX power 1,5 kW 2,2 kW 

Frequency 50 / 60 Hz 

Power cord 2 + 1 x 1mm2 

Fuses 5x20 10A 6.3x35 F12A 

Heat transmitted 3.6 E6  J / hour 

C
H

A
M

B
E

R
 MAX working pressure 2.4  bar (relative) 

MAX empty - 0.9 bar (relative) 

MAX temperature 138 °C 

Material Inox AISI 304 

Size (mm) Ø 245 x 320 Ø 245 x 500 

C
L

E
A

N
 

W
A

T
E

R
 

T
A

N
K

 Volume 4,5 l 

Usable cycles 4 2 

Material polyethylene 

U
S

E
D

 
W

A
T

E
R

 
T

A
N

K
 

Volume 4,5 l 

Usable cycles 4 2 

Material polyethylene 

MAX temperature used water 50°C 

B
A

C
T

E
R

IO
L

O
G

IC
A

L
 

F
IL

T
E

R
 Diameter 56 mm 

Filtering capacity 0.3 m 
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05 OUTPUTS AND INDICATORS LIST 
 

O
U

T
P

U
T

S
 A

N
D

 IN
D

IC
A

T
O

R
S

 L
IS

T
 (

F
ig

.A
) 

00 Spacer 

01 Tap for emptying used water tank 

02 Tap for emptying clean water tank – (tap filling up trought osmosis) 

03 Exceeding full for used water tank 

04 Pipe fitting for emptying used water tank (back) 

05 Feeding socie with fuses 

06 RS232 serial port  

07 Socket for connection of osmosis system 

08 Bacterial filter   

09 Pipe fitting for manual willing up of clean water 

10 Main switch 

11 SD CARD Slot 

12 Display 

13 Pipe fitting for discharging used water (front) 

14 121°C Cycle 

15 134°C Cycle 

16 134°C Fast Cycle 

17 134°C Flash Cycle 

18 134°C Safety Cycle 

19 134°C Prion Cycle 

20 134°C Prion Fast Cycle 

21 Helix / Bowie&Dick Test 

22 Vacuum Test    

23 MAX level used water tank 

24 MAX level clean water tank 

25 MIN level clean water tank 

B-M1 Multifunction push button 1 

B-M2 Multifunction push button 2 

B-M3 Multifunction push button 3 

PUMP 
WATER 

Push button for filling up of water 

SELECT 
CYCLE 

Push button for selection of cycle 
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06 UNPACKAGING 
 

The autoclave is shipped in a suitable package to be transported and moved easily and to 
protect its contents. 
 

The packaging must not be subject to impact, must be handled with care and avoid 
dropping it or roll it. 
 

In case autonomous handling means are not available handle the packaged autoclave 
always in two persons. 
 

Autoclave is placed on wooden pallet and packed with corrugated cardboard internal and 
external application. 
 

For remove the autoclave to its pack please remove first the corrugated cardboard. For lift 
the autoclave please use the belts. 
 
 

 

The autoclave shall have to be handled by at least two people and by using 
belts only. 

 

Do not lift the autoclave from the inferior part of the door or command panel, 
this incorrect operation can create problems of a mechanical nature. 

 
 
 
ATTENTION: Always conserve original packaging. 
 

All’interno the package you will find the following documents: 
 

 USER’S MANUAL: to be read with attention and kept in a place available to all operators 
assigned to sterilization. 
 

 CERTIFICATION: which must be conserved.  
 

 INSTALLATION REPORT - TESTING AND GUARANTEE CONDITIONS: must be 
completed upon installation of the machine following the instructions indicated on the 
form. 

 

 QUICK USE GUIDE: should be kept in the vicinity of the machine. 
 

 CERTIFICATION OF SAFETY WALVE. 
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07 ACCESSORIES 
 

DUAL TRAY HOLDER 
 ONYX 5.0 ONYX 8.0 

Material Alluminium anodized 

Size (L x H x P)  192 x 165 x 280 192 x 165 x 460 

Picture 

 
Fig.1 

Envelope standard 1 
Code SXBA349 2ZXZA0073 
 

TRAY 
 ONYX 5.0 ONYX 8.0 

Material Alluminium anodized 

Size (L x H x P) 183 x 17 x 284 185 x 17 x 460 

Picture 

 
Fig.2 

Envelope standard 4 
Code DANA049 DXLA349 
 

TRAY EXTRACTION AND DOOR ADJUSTMENT WRENCH 
 

Use for extract the trays and for door adjustement (par. 15) 
 

Picture 

 
Fig.3 

 
Fig.4 

Envelope standard 1 
Code DANA008 
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CHAMBER AND DOOR GASKET CLEARING SPONGE 
 

Use to clean sterilization chamber and door gasket (par. 15) 
 

Picture 
 

Fig.5 

Envelope standar 1 

Code CPMG004 
 

WATER FILLING PIPE WITH FILTER AND PIPE FITTING 
 

Use for manual water loading on the front of autoclave (par. 10.2) 
 

Picture 

 
Fig.6 

Envelope standard 1 

Code DANA099 + DXBA711 + CPRG117 
 

WATER DISCHARGE PIPE 
 

Use to drain the water used from the faucet on the front of the autoclave (Fig.A–pos. 13 ) - 
(par. 10.8) 
 

Picture 

 
Fig.7 

Envelope standard 1 

Code DANA130 
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FITTING FOR REAR TAPS DISCHARGE 
 

Tighten the loading faucet (Fig.A-pos. 2 ) to empty the loading tank and tighten the drain 
faucet (Fig.A-pos. 4 ) to empty the drain tank. 
 

Picture 

 
Fig.9 

Envelope standard 1 

Code CPRG096 
 

PIPE FOR DISCHARGE UTILITIES 
 

1 - Clean water overflow hose 
2 - Used water overflow hose 
 
1- Connect one end of the hose to the clean water overflow hose fitting (Fig.A-pos. 1 ), and 

the other in a water recovery container. 
 
2- Connect one end of the hose to the fitting (Fig. A–pos. 3 ), and the other to a used water 

recovery container. 
 

Picture 

 
Fig.10 

Envelope standard 3 mt. 

Code SXBA799 
 

BLACK PLASTIC SPACER PIN  
 

Put the spacer in the autoclave’s back panel (Fig.A–pos. 0 ). It’s necessary for guarantee a 
good ventilation if you place the autoclave near a wall. 
 

Picture 

 
Fig.8 

Envelope standard 1 

Code CPAP014 
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POWER SUPPLY CORD 
 
Take the power supply cord provided (pos. B ) and insert the female plug (Fig.A-pos. 5 ) in 
the socket of the back panel of the autoclave then insert the male plug (pos. A ) in the 
electric plug of the system. 
 

Picture 

 
Fig.11 

Envelope standard 1 

Code CECG006 
 

MEMORY CARD 
 
To be used to memorize the autoclave cycles (for the best compatibility with the device, it is 
advisable to always use the original memory card).  
WARNING: The card contains the software reading log cycle - Carry out the rescue 
and installed on the PC before the commissioning of the autoclave (see par.12) 
 

Picture 
 

Fig.12 

Envelope standard 1 
Code CEGS001 
 

IMPORTANT 
Ask for and use only and exclusively original accessories. 
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08 INSTALLATION 
 

 

 ONYX 5.0 ONYX 8.0 

A 650 mm 795 mm 

B 474 mm 

C 497 mm 

D 
Max. hatch 

opening

495 mm 

E 425 mm 

F 425 mm 

G 402 mm 435 mm 

H min. 50 mm 

I 74 mm 

L 170 mm 275 mm 

M 525 mm 575 mm 
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1. Install the autoclave in environments suitable to sterilization. 
 
2. The premises have to be suitably lit and ventilated, in compliance with regulations in 

force. 
 
3. Install the autoclave away from heat sources and water splashes. 
 
4. Position the autoclave on a surface, suitable to support the weight (80 Kgs.) and with 

adequate dimensions. 
 
5. Place the autoclave at a height allowing easy intervention by the operator for inspection 

and clearing of the whole sterilization chamber. 
 
6. Open the door of the autoclave and remove all packages containing the single 

accessories  from inside the sterilization chamber. 
 
7. Leave inside the sterilization chamber only the tray carrier with the trays. All other 

accessories should be positioned in a separate space available to operators. 
 
8. Don’t put anything on the autoclave. 
 
9. Do not lean on the door. 
 
10. Leave a space of at least 5 cm in the rear of the autoclave, using the spacer         

(Fig.A–pos. 0  / Fig.8) and in the sides of the unit to ensure the ventilation required. 
 
11. Make connections of supplied pipes in the back (chapter 7). 
 
12. Always make sure the electrical system to which the autoclave is to be connected is in 

conformity with the legislation in force and sized to suit the specifications of the said 
device. 

 
13. Connect the power supply cord to the socket on the rear panel of the autoclave    

(Fig.A–pos. 5 ). 
 
14. Connect the electrical plug to the system ensuring that it is adequate to the supply of the 

machine. 
 

NOTE: 
Do not use extensions, reducers or adapters for connection as this could 
cause micro interruptions with consequent generation of alarm signals. 

 
15. Turn the autoclave on by pressing the mains switch (Fig.A-pos. 10 ) and open the hatch 

of the autoclave itself. Wait a few seconds, there will be two acoustic signals to inform 
you of the acquisition of the parameters for the automatic barometric alignment, at the 
same time the text DOOR OPEN will appear on the display. 

 

NOTE: 
Never select a command before hearing the two sound signals, the 
autoclave will not accept the chosen programming. 
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09 PROGRAMMING DISPLAY 
 
From the first page press Setup to enter the autoclave setup menu. 
 

LANGUAGE 

 

Press the central button to change the language of menus and vocal 
messages. 

 
 

 

 

Press the arrow to shift to the next item 

 
 

DATE AND TIME 

 
Press the central button to enter the date/time setup. 

00:00 

00/00/1900 

           

When the box flashes press the arrows to select 
the desired value. 

00:00 

00/00/1900 

 

 
 

Press once more the central button to move 
among boxes and the arrows to select a value.  

Go on until the last value is selected. 

Press the central button for the last time to display 
the final selection page. 

 
 

 Press to confirm selected values and go back to the setup menu 

 Press to restart the procedure 

 Press to cancel selected values and go back to the setup menu 
 
 
 
 
 
 
 
 
 

v 

     ▬ 

X 
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EXTERNAL PRINTER 
After the printer installation (optional accessory, following the instructions inside), is 
possible to print the traceability adhesive labels to be stuck on the wrap before starting 
sterilization is entered. 
 

00 

                   

When the box flashes press the arrows to 
select the number of labels to be printed. 

 
Press the central button to move to the next selection. 

00 

                   

When the box flashes press the arrows to 
select the number of months before expiry.  

Press the central button for the last time to 
display the final selection page. 

 

 
 

SETUP OSMOSIS SYSTEM 

 USE OSMOSI’S SYSTEM : On / Off  with the button  the supply system with 
osmosis device (optional). When the system is activated the charge pump is 
disconnected.  

 CYCLES SINCE CHG: Cycles from the last change of filters are visualized.  
 RESET OSMOSI COUNTER: It allows you to reset the counter when you replace the 

filters. 
 
 

BACTERIOLOGIC FILTER 
 CYCLES PERFORMED: Cycles from the last change of filter are visualized. 
 RESET COUNTER: It allows you to reset the counter when you replace the filter. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

     ▬ 

▲  ▼

     ▬ 

▲  ▼
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ACCOUNT MANAGER 
 SHOW USERS: It allows you to see the already registered users. 
 NEW USERS: It allos to register a new user. 
 DELETE: It allows you to delete already registered users. 
 LOAD CHECK: on/off (par. 10.6). 
 
NEW USERS: 

 Press the central button to enter a new user. 

          

ENTER NAME: When the box is flashing, press the arrow 
keys to scroll the characters until the desired user name, 

confirming each box with the button . 
 
ENTER PASSWORD: choose the desired password using 
the same procedure the “enter name”. 

 
 

SERVICE MODE 
Access to the service menu (after password entry). This mode is reserved exclusively for 
the setup by an authorised personal. The manufacturer shall not be held responsible for 
any tampering with or injury to unauthorised staff. 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

     ▬ 
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10 USE INSTRUCTION 
 

After installing the autoclave proceed with preparation and use.  
 
10.1 Turn on the autoclave and barometric alignment 
 

Press the main switch (Fig.A–pos. 10 ). After the display of the logo, the autoclave checks 
the memory and the connections. Once checks are over the autoclave shifts to the 
operating setup. 
 

 
 
Open the door and wait for some seconds until an acoustic signal informs that the 
automatic barometric alignment values have been acquired; at the same time the display 
shows the message DOOR OPEN. 
 

THE AUTOCLAVE IS READY FOR USE 
 

ATTENTION: 
Selecting any cycle, excluding vacuum cycle, will activate the preheating 

mode of the autoclave. 
Be careful, do not touch the surfaces of the boiler because they are hot. 
 
10.2 Clean water tank filling 
 

Connect the hose supplied (Fig. 6) to the front fitting of the autoclave (Fig. A-pos. 9 ). 
 
Put the other end of the hose with the filter inside the demineralised or distilled water 
container. 
 
At this point, press the PUMP WATER button to operate the water loading pump and keep 
it pressed until the countdown appears. 
 
The pump loads the clean water tank inside the autoclave. If the maximum level is not 
achieved within 180 seconds the pump stops automatically and it will be necessary to press 
button B-PUMP. 
 
The pump stops automatically when the maximum level is achieved. 
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10.3 Characterisstics of the water to be used 
 

TABLE SHOWING THE QUALITY LEVELS LAID BY THE  EN13060 
 

CEN STANDARD  EN13060  
Evaporation residue  10 mg/l 
Silicon oxide  1 mg/l 
Iron  0.2 mg/l 
Cadmium  0.005 mg/l 
Lead  0.05 mg/l 
Remains of heavy metals apart from iron, cadmium, 
lead  0.1 mg/l 

Chloride (Cl’)  2 mg/l 
Phosphate (P20s)  0.5 mg/l 
Conductivity (at 20°C)  15 s/cm 
Ph value (acidity level) 5  7,5 
Appearance Transparent, clear, without deposits 
Hardness (and alkaline earth ions)  0.02 mmol/l 
 
 

10.4 Loading of the materials in the autoclave 
 

Arranging the materials to be sterilized on the provided trays, as follows: 
 Do not superpose the materials 
 Arrange the wrapped materials with the paper side facing upwards   
 Never bring the materials into contact with the sterilization chamber or the autoclave door  
 Put scissors and dental forceps with blades open 
 

                  
 

 
 
 

After loading the materials, close the door of the autoclave. The display will show the icon 
and the message DOOR CLOSED.  
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10.5 Starting the sterilization cycle 
 

After the steps listed above, choose the most suitable STERILISATION program for the 
prepared load, by pressing the SELECT CYCLE button.  
After choosing the program, start the cycle by pressing the Start button. The door will lock 
automatically, and the cycle will begin. 
During the cycle the display shows all parameters and information related to the cycle in 
progress. In this setup the display shows: the type of cycle, the cycle status, the time 
remaining before the end of cycle (for the Vacuum Test it identifies the whole cycle, while 
for all the other cycles it identifies the sterilization phase plus that of drying), the number of 
cycles done by the machine and the button Info allowing access to the list of working 
parameters. 
 

 
 
 
10.6 End of cycle 
 

An acoustic signal will inform the operators about the finished STERILISATION cycle and 
the display will show the END CYCLE icon and message. 
 
Unlock the door by pressing the Unlock button displayed on the display by one of the three 
multi-function buttons. Should there be pressure present inside the chamber, the button will 
not trigger the unlocking. Wait for the complete depressurization of the chamber and repeat 
the operation. With the door unlocked, pull the door handle and open. 
 
Now, if the CHARGE CONTROL (SETUP  ACCOUNT MANAGEMENT) is “ON”, is asked 
to validate the charge by the user. If the charge is validated, give consent specifying USER 
and USER PASSWORD, afterwards will be given the confirmation of VALIDATED 
CHARGE. If the charge doesn’t result validated you have to give negative result to end the 
operation in NOT VALIDATED CHARGE. 
 
10.7 Unloading the sterilized materials 
 

Wear personal protective equipment in compliance with regulations on safety and hygiene 
at work. Extract the trays by using the spanner provided (Fig.3/4), let rest the instruments 
and store them in environments which are not exposed to contamination. 
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10.8 Discharge used water 
 

When the used water level LED (Fig. A-pos. 23 ) lights up, the used water collection tank 
must be emptied.  
 
If nothing is done, the operation of the autoclave is blocked. 
 
Take the hose supplied (Fig.7), and insert it into the used water drain fitting located on the 
front of the autoclave (Fig.A-pos. 13 ). Put the other end of the hose in a container and 
unscrew the ring nut, turning it anticlockwise, the water will fall into the container, emptying 
the tank. 
 
IMPORTANT: 
 
A  - The hose located in the receiving container must never touch or be immersed in the 
discharged water, otherwise sucking up will occur. 
 
B - Always wait until the discharge water has been completely drained. The used water 
maximum level LED turns off when some water still remains into the tank, consequently do 
not considered it as a reference for this operation. 
 
When drained, screw in the ring nut and remove the hose. 
 
10.9 Interruption of a sterilization cycle 
 

A sterilization cycle can be voluntarily interrupted by pressing the button Stop for at least 2 
seconds. 
 
The autoclave will send out a beep and the display will show the alarm message A001. 
 
 

 
 

  

 

For reset the alarm, press at the same time, the multifunction push buttons on the Reset 
bar up to the cancelling of the same. 
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11 STERILIZATION CYCLES 
 

11.1 Descriptions cycles 
 

The autoclave has three series of cycles: 
 

A – operation cycles 
B – night cycles 
C – test cycles 
 

11.2 Operation cycles 
 

All operating cycles, have the fractional vacuum system and can sterilize hollow, porous 
and solid materials, however, are differentiated according to user priority and to 
characteristics of the materials for the sterilization. The sterilization   temperatures possible 
are 121°C and 134°C. 
- Cycle 121°C Standard: it is used for thermolabile materials, load capacity up to 5 Kg 
(Onyx5.0) / 8 Kg (Onyx8.0) with a normal cycle time. 
- Cycle 134°C Standard: it is used for not thermolabile materials, load capacity up to 5 Kg 
(Onyx5.0) / 8 Kg (Onyx8.0) with a normal cycle time. 
- Cycle 134°C Fast: keeps the use of 134°C Standard but it is created for low loads (up to 
1,5 Kg (Onyx5.0) / 2 Kg (Onyx8.0)), consequently also the time of the cycle is shorter. 
- Cycle 134°C Safety: created for immediate needs of the instrumentation, has a shorter 
cycle time, load capacity up to 5 Kg (Onyx5.0) / 8 Kg (Onyx8.0). Not suitable for wrapped 
loads. 
- Cycle 134°C Flash: how to Safety cycle has been created for immediate need  of the 
instrumentation but with a load capacity up to 1,5 Kg (Onyx5.0) / 2 Kg (Onyx8.0). Not 
suitable for wrapped loads. 
- Cycle 134°C Prion: created for Creutzfeldt-Jakob disease (mad cow syndrome), load 
capacity up to 5 Kg (Onyx5.0) / 8 Kg (Onyx8.0), the cycle time is higher than 134°C 
Standard. 
- Cycle 134°C Prion Fast: created for need to perform a Prion Cycle with lower load (up to 
1,5 Kg (Onyx5.0) / 2 Kg (Onyx8.0)) in a shorter time. 
 
Please refer Fig.B for a detailed summary. 
 

11.3 Night cycles 
 

The autoclave is equipped with a economizer special device. It is possible to perform all 
cycles mentioned without operator. At the end of the cycle, if the door isn’t opened, the 
autoclave automatically turns off, remains turn on the main switch only (Fig.A-pos. 10 ). 
Upon arrival of the operators, simply press any button to turn on the autoclave and read to 
display the outcome of the cycle. 
 

11.4 Test cycles 
 

Available test cycle: 
 
- Bowie&Dick test – par. 13.3 
- Helix test – par. 13.4 
- Vacuum test – par. 13.5 
 
 



                                                                                                           ENGLISH 
 

23 
 

11.5 Cycle diagram 
 

 

CYCLE DIAGRAM 
 
 

T1,T2,T3 
pre heater fase and 

vacuum fases 

T4 
sterilization 

T5 
drying 

 
 

TABLE OF TESTS TYPE AS RULE  EN13060 

Type test Operative cycle 

Dynamic sterilizer chambre pressure X 

Air Leakage X 

Empty chamber X 

Solid load X 

Small porous items X 

Small porous loads X 

Full porous load X 

Hollow load B X 

Hollow load A X 

Multiple wrapping X 

Dryness, solid load X 

Dryness, porous load X 
 
 

TECNO-GAZ is at your service to provide sterilization tests for 
the management of your sterilization routine 
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12 SOFTWARE VISUALIZATION CYCLES 
 

12.1 Installation 
 
Enter the SD memory card in your computer.  
The LogViewer folder is located at: <SD Card>:\ 
 
Access the SD memory card and copy the LogViewer folder on your computer. 
 
Open the folder LogViewer and run the LogViewer program by double click link, 
recognizable by the magnifying glass icon (Figure1). 

 

Figure 1: LogViewer folder. Double click on logviewer to run it 

 

If the program doesn’t start by link, open bin folder and run program log_viewer, 
recognizable by the magnifying glass icon. 

 

 

WARNING: Please check that Microsoft .NET Framework is installed on 
your PC. If it is not,  open the folder Microsoft.NET available on SD card 
and install the executable file contained inside. 
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12.2 Language setting 
 
The default language at first run of LogViewer is English. It is possible to change the 
language by the dropdown menu on right of window. Languages available are English, 
Italian, German, French e Spanish. The program saves the selected language and to next 
run loads the user interface in that language. 

12.3 Single log file viewing 
 
Select by dropdown menu File → Open (Figure 2) to view the cycle details of a particular 
log file. The program will show a dialog box for the file selection that you want open. 

 

Figure 2: Logviewer window, Open item 

 

The program shows the cycle log as showed in Figure 3. In the window are showed 
different kind of data: 
 

 Step of the sterilization cycle; 
 Date and time of data recording; 
 Time to end of cycle; 
 Chamber temperatures and pressure (values returned by probes T1, T2 e P1); 
 Mains voltage; 
 Cycle outcome, readable on last line. 

 
The kind of cycle related to log is returned in the box in center position.  
 
During the log viewing, Options item is present in menu bar and allows access to two 
functions: Make Report and Make Log PDF. 
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Figure 3: log viewing mode of Vacuum cycle 
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12.4 Open directory 
 
Select by dropdown menu File → Select (Figure 4) to browse the log files in a particular 
folder. The program will show a dialog box to specify the path to browse. 

 

 

Figure 4: item Select, for browsing folder 

The program display only *.log files with valid content in the selected folder, and shows a 
list as in Figure 5. 
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Figure 5: browsing folder 

Log files are showed as a list that provides a preview with serial number of sterilizer, cycle 
number, kind of cycle and the outcome. By single-click on a list item, the detailed report of 
corresponding log is displayed, as showed in Figure 3. 
In this case, on the left of the box that shows the kind of cycle, is displayed the Back button 
to come back to browsing window. 
During the folder browsing, Options item is present in menu bar and allows access to two 
functions: Make Report and Make Log PDF. 
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12.5 Make Report 
 
During log viewing, by selecting from menu Options → Make Report, the program returns a 
table with all cycle data and show them in a new window (Figure 6). 
 

 

Figure 6: report window 

From this window is possible display a print preview (File → Print preview) or print (File → 
Print). 
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12.6 Make PDF 
 
During the viewing of a log, by selecting from menu Options → Make PDF, Logviewer make 
a PDF file which contains the cycle details (Figure 7). 

 

Figure 7: menu Options, the item Make PDF 

The PDF file will be created in the same folder where *.log file is located, in sub-folder 
Report, accessible by File Manager tool in Windows. If Report folder doesn’t exist, it will be 
created. At the end of the process, the program open the destination folder by a window of 
File Manager in Windows. 

 

Figure 8: when PDF file is created, the program saves the file Report folder,  inside the log 
file origin folder 

The created file name is compound by serialnumber-cyclenumber.pdf. 

 

.. 

LOG 

REPORT 
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12.7 Make folder PDF 
 
In browsing folder mode is available the Make folder PDF function in Options item of menu 
bar. 

 

Figure 9: Make folder PDF function, visible in browsing folder mode 

 

On mouse click, a loading bar that indicates the progress of the process is displayed. The 
PDF files will be created within the browsed folder, in subfolder Report, accessible by File 
Manager tool of Windows. If the folder Report doesn’t exist, it will be created. 

At the end of the process, the program opens the destination folder by a window of File 
Manager in Windows. 

The created file name is compound by serialnumber-cyclenumber.pdf. 
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Figure 10: Browsed folder with LogViewer and destination folder of made files. 
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13 INSTALLATION OSMOSIS SYSTEM 
 

Setting osmosis system 
 

The autoclave is also designed for loading demineralised water through an external osmosi 
demineralisation system (optional accessory). 
The operator before installing the system, must schedule the autoclave following the 
instructions below: 
Turn the autoclave on by pressing the mains switch (Fig. A-pos. 10 ). 
 
When the autoclave is brought up on the operating screen, press Setup and select the 
menu setup osmosis system. 
 
Activate by setting the USE OSMOSI’S SYSTEM item to ON.  
 
Exit the menu and return to the operating screen. 
 

NOTE 
Connected by a demineraliser, if the maximum water level has not been 
reached, the operation of the autoclave will be blocked. 

 
WARNING:  

The number on the osmosi management screen indicates how many STERILISATION 
cycles have been performed since changing filters.  

When you reach the maximum number of cycles, a message on the display will inform the 
user. It's necessary to remember to reset the cycles counter when you change the filter on 
the osmosis system selecting RESET OSMOSI COUNTER in the SETUP OSMOSIS 
SYSTEM submenu. 

 
Connection of the demineralizer 
 

Here as follows the detail of the specific connection to the autoclave of the water supply 
hose and electrical plug connection: 
 

 Turn off the autoclave, if ON (Fig.A–pos. 10 ). 

 Close the cock upstream the demineralizer; 

 Install the demineralizer as indicated in its manual; 

 Wrap the male thread of the hose coupler with teflon or another component ensuring 
water tightness; 

 Screw the hose coupler on the female thread of the clean water discharge            
(FIG.A–pos. 2 ); 

 Insert the hose from the demineralizer into the hose coupler and screw it to the 
autoclave; 

 Insert the feeding coupler of the demineralizer into the port  (FIG.A–pos. 7 ) on the rear 
panel of the autoclave; 

 Open the valve upstream the demineralizer; 

 Be sure there is no water leakage; 
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 Switch on the autoclave; 

 Carry out one or several sterilization cycles to check for the correct connection and 
mainly to be sure of the absence of any leak. 

 
 

 
At the end of every day always close the cock upstream the demineralizer 

 
Connect the demineralizers exclusively to suitable autoclaves 

NOTE 
For the connection of the demineralizers to the autoclaves, see also the 
demineralizer manual. 

NOTE 
The first filling can take a longer time. Afterwards the autoclave will 
automatically fill during cycles 
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14 MAINTENANCE 
 

Correct maintenance of the autoclave assures correct funcioning of it and a secure saving 
in terms of time and costs for assistance and maintenance. The following operations are 
compulsory feasible by operators. 
 

Cleaning of chamber Every 20 cycles or one a week 
 

Clean periodically the chamber, remove eventual deposits or debris, thus avoiding the 
introduction in the discharging circuit of material which can cause obstructions. For correct 
cleaning use only deminerlized water and the abrasive sponge provided (non abrasive side 
– Fig. 5). 
 

To execute absolutely with cold chamber to avoid burns – Never use solvents, detergents, 
chemical solutions, descaling agents or other similar products. 
 

 
Cleaning of chamber filter Every 20 cycles or once a week 
 

Pull up the filter (spare code DXBA091), paying attention not to damage it, wash with 
demineralized water and dry with cloth. Then replace in the seat, making sure that 
protrudes about 15 mm. 
 

   
 
Cleaning of tray and tray holder Every 20 cycles or once a week 
 
Clean with sponge supplied (non abrasive side) and demineralized water. 
 
Change of the bacteriological filter Every 200 cycles or when it assumes a dark colour 
 

Substiture the bacteriological filter (Fig.A–pos. 9 ) turning it counterclockwise to unscrew 
and clockwise to screw. Use only original filter (spare code DAVA101). It's necessary to 
remember to reset the cycles counter when you change the filter selecting RESET 
COUNTER in the BACTERIOLOGIC FILTER submenu. 
 

Cleaning of the door gasket Every 20 cycles or once a week 
 

Periodically remove eventual residuals which are deposited on the circumference of the 
seal (spare code DANA038) using water and the sponge provided (non abrasive side), or 
else a moistened cloth 
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Door regulation Every 2 mouths  
 
To preserve the functional integrity of the machine, the closing pressure of the door P must 
be adjusted by acting on the door regulator. Use the lever and rotate 60° anticlockwise to 
increase the closing pressure; if instead you want to decrease the closing pressure, turn   
60° clockwise. 
 

 

 

Door adjustment 
clockwise 

 
(Reduction of closing 

pressure) 

 

Door adjustment in 
Counterclockwise 

 
(Increased closing pressure) 

 

1 

2 

Door adjustment lever 

60° 
Width of the arc 

1 

2 

2 

1 

Start / End of travel 

P_    

P_    

P_    
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To execute a wider arc, it is necessary to disengage the levers by keeping them together as 
in Fig. 2 and bring them to the start of stroke 1 or 2 (If you want to rotate the lever to 
decrease the closing pressure, start of stroke 2. If you want to rotate the lever to increase 
the closing pressure, start of travel 1) After having brought the levers to the start of travel, 
release them as in Fig. 1 and rotate again in the desired direction. 
 

Fig. 1 – Lever inserted 

  

Fig. 2 – Lever disengaged 
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14.1 Authorized technicians ordinary maintenance 
 

 

EVERY TWO 

YEAR / 

EVERY 1000 

CYCLES 

Clean the chamber 

Clean the metal filter in the chamber 

Replace the seal of the chamber door (DANA038) 

Lubricate the closing system of the chamber door 

Adjust the closing system of the chamber door 

Replace the bacteriological filter (DAVA101) 

Replace the water loading filter (DARA054) 

Clean the Y brass filter downstream of the radiator 

Clean the water loading solenoid valve or replace it if necessary 

Clean the tanks 

Check the tank level probes 

Clean the radiator and cooling fans 

Check the condition of the electrical/pneumatic circuit 

Check that there are no traces of disinfectant in the pneumatic circuit. 

Please note: ignoring traces of disinfectant may result in the need for 

supplementary maintenance of the equipment 

Check the safety valve 

Check the efficiency of the vacuum pump 

Perform validation in compliance with the local standards and on the basis 

defined by the local standards 

Perform the electrical safety tests in compliance with the local standards 

and on the basis defined by the local standards 

Measure the conductivity of water               ………………….  S/cm 

AFTER 2000 

CYCLES 

Replace the valves and o-rings of the vacuum pump – Clean/check the 

condition of the Knf membranes (CPGM025 x4 – CPGM043 x2) -  

Thomas (CPGM050 x4 – CPGM051 x4 – CPGM052 x2) 

Check the three N/C solenoid valves 

Check the heating part 

AFTER 3000 

CYCLES 

Replace the three N/C solenoid valves (CEECG021 x3) 

Replace the heating part (DXBA835 or DHYA035) 

Clean/check the condition of the membranes of the vacuum pump 
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15 MESSAGES OF ERRORS 
 

Messages of error are emphasized through an Alfa-numerical code, consisting in a letter 
and three numbers. 
 

 

If an alarm message is diplayed (code "A") the cycle is to be considered 
aborted: it will be necessary to repeat all the preparation and sterilization 
operations. 

 

To reset alarms and errors hold down at the same time the buttons under the bar indicated 
with Reset. 
 
 

ERROR CAUSE SOLUTION 

A 001 Cycle interrupted by the user  Reset and restart the system 

A 101 Vacuum not archieved in 10 min. 
 Check the gasket 
 Check the door adjustment 
 Reset and restart the system 

A 111 
Vacuum not maintained on the first phase 
of VACUUM TEST 

 Check the gasket 
 Check the door adjustment 
 Reset and restart the system 

A 121 
Vacuum not maintained on the second 
phase of VACUUM TEST 

 Check the gasket 
 Check the door adjustment 
 Reset and restart the system 

A131 
During preheating phase the autoclave did 
not load right water amount  Reset and restart the system 

A132 Error in the flow-meter operation  Reset and restart the system 

A133 
Pressure above the allowable limit during 
the water recall for the warmup phases  Reset and restart the system 

A 200 Error in the control of the EV operation  Reset and restart the system 

A 400 
A 401 
A 403 
A 405 

Error in the locking operation  Reset and restart the system 

A 551 Pressure out of limit 
 Let cool the room 
 Reset and restart the system 

A 637 Error in the access to the memory card 

 Check that the SD card is 
correctly inserted 

 Chech SD card: lever might 
have moved on “lock” position 

 Reset and restart the system 

A 651 
Reading of the T1 probe during sterilization 
above the maximum limit 

 Let cool the room 
 Reset and restart the system 
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A 653 
Reading of the T2 probe during sterilization 
above the maximum limit 

 Let cool the room 
 Reset and restart the system 

A 661 Error in the probe reading  Reset and restart the system 

A 662 Error in the probe reading  Reset and restart the system 

A 701 
Error for failed pressure achievement 
during the first two phases of the warm-up  Reset and restart the system 

A 711 
Error for failed pressure achievement 
during the third phase of the warm-up  Reset and restart the system 

A 751 
Reading of the T1 probe during sterilization 
below the minumum limit  Reset and restart the system 

A 753 
Reading of the T2 probe during sterilization 
below the minumum limit  Reset and restart the system 

A 781 
Temperature of the 121°C cycle out o the 
maximum limit 

 Let cool the room 
 Reset and restart the system 

A 782 
Temperature of the 134°C cycle out o the 
maximum limit 

 Let cool the room 
 Reset and restart the system 

A 801 
Errors of out of maximum time during the 
first phases of discharge 

 Clean the filter in the room 
 Reset and restart the system 

A 811 
Errors of out of maximum time during the 
last phase of discharge 

 Clean the filter in the room 
 Reset and restart the system 

A 901 
Cycle interrupted due to power supply 
failure 

 Check the power supply 
system of the machine and of 
the room. 

 Reset and restart the system  

 

It’s need to make a SD CARD periodic backup. 

In the event of one of the alarms persisting after some time, consult technical assistance. 
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16 SOLUTION TO OPERATING PROBLEMS 
 

In most cases alarms or errors are caused by lack of attention or lack of familiarity with 
some technical and operational aspects. You will find below the list of some anomalies with 
associated solutions. 
 

16.1 The autoclave does not dry materials correctly 
 

 Replace the bacteriological filter with a new original one. 
 Non original trays, without holes or with different holes made of different material have 

been used.  
It is advisable to use original trays only. 

 Instruments have not been arranged correctly. Carefully comply with instructions of par. 
10.4 
 

16.2 The autoclave chamber has turned white 
 

 Change immediately the type of water used, use exclusively demineralized or distilled 
water, as indicated in the previous chapters and then clean the chamber. 

 The whitish colour may be a consequence of the evaporation of organic materials from 
the instruments. Instruments should undergo a more suitable and deeper cleaning.   

 Check the demineralizer installed. 
 

16.3 The autoclave chamber hass bluish-green stains 
 

 Instruments have not been cleaned correctly after the cleaning, rinse more carefully, if 
the stains remain apply to the phone technical service. 
 

16.4 The sterilization cycle interrupts without any patent reason 
 

 Check whether the autoclave is connected to the power mains through extensions, 
reducers or adapters, if so remove such accessories and connect the autoclave directly 
to the power socket. 
 

16.5 The autoclave does not receive controls 
 

 I The autoclave is carrying out the automatic barometric alignment, wait for the double 
acoustic signal after the door opening , then set functions. 

 The demineralized water tank is empty, the Led indicating the minimum level is ON, fill 
the tank with pure water. 

 The used water tank is full, the Led indicating the maximum level is ON, discharge used 
water .  
 

16.6 Stains on instruments 
 

 Instruments get yellow due to the deposit of residual chemical fluid which has fixed on 
the instruments due to heating. The rinsing was not suitable. 

 The sterilization chamber has yellow stains. Some instruments with traces of chemical 
fluid  have been loaded into the chamber, such fluid has fixed due to heating. The rinsing 
was not adequate. 

 Instruments have whitish stains, the rinsing has been done with very limy water and the 
instruments have not been carefully dried. For the final rinsing we suggest the use of 
demineralized water and a careful drying of the instruments 

 Instruments have blackened since the material they are made of contain a high 
percentage of carbon. 
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17 PROCEDURE FOR SERVICE AND ASSISTANCE 
 

In case of failure, review, validation, contact the service centers 
TECNO-GAZ S.p.A. 
 

 
See annex for Authorized Service Centers 

Cod. 0Z00H0002 

 
Assistance will assess the return at headquarters or with the intervention of a technician, 
and having viewed the machine in order to draw up a cost estimate, which will be forwarded 
to the distributor customer who will forward it to the final customer, for acknowledgement 
and signing. 
 
After receiving prior written acceptance of the cost estimate, the autoclave will be serviced 
and reshipped according to times indicated on the cost estimate.  
 
In case the autoclave must be shipped for repairs, controls, reactivation, revisions, 
validations follow the obligatory indications below: 
 

1. Use the original packaging; if this is no longer in your possession, use adequate 
packaging. The merchandise travels at risk to the sender. 

 

2. Ship the autoclave only (do not include any component contained in the accessories kit). 
 

3. Carefully clean the sterilization chamber and autoclave in general before shipping. In 
case it arrives dirty or with residual the autoclave with be returned without being 
repaired, or it will be put through a cleansing action and disinfection. 

 
4. Always empty the clean water tank through the attachment located on the back of the 

autoclave (Fig.A–pos. 2 ). 
 

5. Always empty the used water tank through the attachment located on the back of the 
autoclave (Fig.A–pos. 4 ). 

 
6. Indicate by letter and insert in the package a document which indicates precisely the 

irregularity or  service desired. 
 

7. Ship at your expense, otherwise you will be billed for shipping. 
 
All non original packaging which arrives will be disposed of. 
 
Autoclave will be returned with new and original packing to insure maximum protection for 
your autoclave during shipping. Cost of packaging will be charged to client. 
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A CONSUMABLE SPARE PARTS SUMMARY 
 

 

PORTATRAY STANDARD 

 

TRAY 

ONYX 5.0 ONYX 8.0 ONYX 5.0 ONYX 8.0 

SXBA349 2ZXZA0073 DANA049 DXLA349 

 

TRAY EXTRACTION 

 

POWER SUPPLY 
CORD 

DANA008 CECG006 

 

SPACER 

 

BACTERIAL FILTER 

CPAP014 DAVA101 

 

FILTER CHAMBER 

 

DOOR GASKET 

DXBA091 DANA038 

 

PIPE FOR CHARGING 
WATER 

 

PIPE FOR 
DISCHARGING USED 

WATER 
DANA099 + DXBA711 + 

CPRG117 
DANA130 

 

PIPE FITTING FOR 
DISCHARGING USED 

WATER 

 

PIPES FOR 
DISCHARGE 

UTILITIES 

CPRG096 SXBA799 

 

SPONGE 
 

 

CPMG004  

CHEMICAL INTEGRATOR 200/S o 215-S BOWIE & DICK 
TEST 

TS001BDT 

BIOLOGICAL INDICATOR TS002ZBK HELIX TEST TS001ZHT 
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